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Preface

This manual accompanies Moore et al.’s Introduction to the Practice of Statistics, Seventh Edition,
(abbreviated /PS throughout this manual). It is intended to guide students in the use of JMP software to
automate the statistical graphics and analyses in the textbook.

JMP’s design goals are for a user to discover more, interact more, and understand more. The correct
graphs are integrated with the right analyses. Because JMP is task-oriented, not method-oriented, you
don’t need to be a professional statistician to use it. You only need to know what questions you wish
answered. JMP runs under the Windows, Macintosh, and Linux operating systems. Academic researchers
and industry use JMP extensively

The American Statistical Association, a 175-plus-year-old organization of professional statisticians,
strongly states: “Efficient computing tools are essential for statistical research, consulting, and teaching.
Generic packages such as Excel are not sufficient for teaching of statistics, ...”. Spreadsheet software was
designed to manage lists and tables of values and to perform bookkeeping-like calculations—not
statistical computations and graphics. Spreadsheet software is not nearly as easy to use as JMP; it can’t
manipulate data nearly as well as JMP, and the underlying statistical and mathematical algorithms in
spreadsheets are not as well tested and reliable as those in JMP.

The IPS CD-Rom contains JMP data tables and text files with data from most of the examples,
exercises, and tables from the textbook. They are also available at the Web site
http://www.whfreeman.com/ips7¢/. We have adopted the following filename convention throughout this
manual.

Textbook Source File Name
Example 1.6 eg01-06.jmp
Exercise 1.38 ex01-38.jmp
Table 1.1 ta01-01.jmp
Figure 1.1 fg01-01.jmp

This manual makes reference to additional datasets to illustrate how to use JMP. Some of these are
bundled with the JMP software and are clearly indicted. Datasets used in this manual as examples are also
available from http://www.whfreeman.com/ips7¢/. These have filenames jm-xxxxX.jmp, where xxxx is
replaced as needed.
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Chapter 0: Introduction to JMP Statistical
Software

Statistics is best learned by practicing with real data. The purpose of this manual is to provide instructions
on how to use JMP statistical software to automate the statistical calculations and graphics presented in
the Introduction to the Practice of Statistics, Seventh Edition, (IPS) by Moore et al.

This manual parallels /PS. Chapters 1 and following of this manual correspond to separate chapters in
the textbooks. These chapters guide you in the use of JMP for the calculations and graphics of the
corresponding textbook chapters. This chapter, Chapter 0, serves as an introduction to JMP statistical
software and discusses:

* getting acquainted with JMP and the JMP data table.
* entering and saving data.

» working with variables and individuals.

* customizing your JMP environment.

If you read this chapter carefully, using JMP will quickly become second nature. You will be able to
produce appropriate graphs and calculations at the click of a mouse and the touch of a button.

Getting Acquainted with JMP and the JMP Data Table

Getting Started and Quitting

JMP is started like any other application on your operating system. Either:
* double-click a JMP data table or script, or
* double-click the JMP icon.

To quit JMP:
* select File = Exit or press ctrl-Q in Windows, or
* select JMP = Quit or press command-Q on the Macintosh.

The JMP Data Table

Data to be processed in JMP must be in a JMP data table. A data table is similar to a spreadsheet but the
rows and columns have a special purpose..

Example: Opening a JMP data table

Start JMP and open the JMP data table Big Class in the Sample Data Directory installed with the JMP
application on your computer

1. Select Help = Sample Data Directory from the menu bar.
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8O # Sample Directory

¥ About the Sample Data Directory

informantion.
Sample fles categorized By Type of analysis

k= Analysis of Variance

* Bivariate Analysis

* Categorical Models
Control Charts

Design of Experiments

Exploratory Modeling
Generalized Linear Models
Item Response
Measurement Systems
Mixed Models
Multivariate Analysis

¥ ¥ ¥ ¥ ¥ ¥ P9 ¥ ¥ ¥ ¥

Monlingar Modelling
Regression

k= Reliability / Sursival
* Time Series

T

B I

e e G LIPS LB~ 0%

Fishbone/lshikawa Charts (Diagram)

Multivariate Analysiz of Variance

This i5 an index of the sample data ables provided with JMP.
Chooss & subject heading below and open i 1o see a liso of
darh tables you Can wie 1o explane that topic. Click the blise
wnderlired File name 1o open & data table, Then, within each
dara table, stuedy the rable potes and oolisma nales for mane

Jample Nles Categarized by Type af data

F Business and Demographic

* Food and Nutrition

¥ Industrial Experiments

¥ Medical Studies

= Positional Data

= Psychology and Social Science
F Sciences

F Sports

Teaching Demons rations

= Examples for Teaching
* Loss Function Templates

2. Press the gray triangle next to Examples for Teaching.

3. Select the first file Big Class.jmp.
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Inspect the data table.

(66 £ Big Class
| ¥-5/0Cols=l
E:;N name age sex | height | weight
1 [KATIE 12 |F 59 95
2 | LOUISE 12 |F 61 123
3 |JANE 12 |F 55 74
4 | JACLYM 12 |F 66 145
5 | LILLIE 12 |F 52 64
6|TIM 12 |M 60 84
7 |JAMES 12 |M 61 128
8 |ROBERT 12 |M 51 79
9 | BAREARA 13 |F 60 112
10 |ALICE 13 |F 61 107
11 [SUSAN 13 |F 56 67
12 |JOHN 13 |M 65 98
13 [JOE 13 |M 63 105
14 | MICHAEL 13 |M 58 95
15 | DAVID 13 |M 59 79
16 [JUDY 14 |F 61 81| |,
17 |ELIZABEETH 14 |F 62 91 i
= ) K1
e e el

The data table 1ooks like a spreadsheet with some enhancements. In the upper-left-hand corner, you
can see that the data table has 40 rows and 5 columns. Look more closely and notice that each of the
columns—name, age, sex, height, and weight—contains the values of a variable and each of the
rows is an individual. Therefore, Big Class contains 5 variables and 40 individuals. In general, the
columns of a data table contain variables and the rows contain individuals.

Menu Headings

JMP provides a menu bar and an icon bar of commands. The two pull-down menus at either end of the
menu bar should look familiar. Let’s examine the items on the menu bar.

¥ JMP Student Edition - Big Class =1
Fle Edit Tables Rows Cols DOE Analyze Graph Tools View Windew Help
ERN=: & ! B R|? b MmE P L+ ESSH O soces v

File performs most routine file functions, such as opening, closing, printing, and saving.
Edit performs most editing functions, such as cutting and pasting.
Tables performs table functions, such as sorting, subsetting, and merging.
Rows performs row operations (i.e., operations on individuals).
Cols performs column operations (i.e., operations on variables).
DOE performs tasks associated with designing statistical experiments.

Analyze performs most statistical analyses.

3
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Graph generates a variety of graphs.

Tools displays a special palette of tools that determine the effect of a mouse action.

View manages the tool bars and displays the Status Bar (Windows only).

Window selects among, organizes, and performs routine window operations on opened windows.
Help accesses the main help feature in JMP.

The menu bar in Mac OS X is the same as above with the addition of a JMP menu. The JMP menu
contains the standard items in an application menu. You can change preferences and quit JMP from it.

@ JMP-SE File Edit Tables Rows Cols DOE Analyze Graph Tools View Window Help
e~

Remarks
* Instructions in this manual will focus on accessing commands through the menus. As you become more
familiar with JMP, you may wish to explore the icon alternatives.

Column Attributes

Inspect the data table Big Class. Notice that each column/variable has a name. Also, note that some of
the columns are left-aligned and some are right-aligned. Alignment is determined by data type. The data
type of a column, or variable, determines how its values are formatted in the data table, how they are
stored internally, and whether they can be used in calculations. The two data types of interest to us are:

Numeric  for columns/variables with numeric values that can be used in calculations. These data
are right-aligned. Age, height, and weight are numeric variables.

Character for columns/variables with numeric and/or character values that can be used to describe
different levels of the variable. These data are left-aligned. Name and sex are character

variables.

Name and data type are two attributes of a column/variable. To see other attributes, use the Column Info
command found in the Cols menu.

Example: Obtaining information about a column

Obtain column information on the variables name and weight.

1. Highlight the columns name and weight by clicking first on the top of the column name and then
ctrl-clicking (command-clicking on a Macintosh) on the top of the column weight.

2. Select Cols ® Column Info.

Inspect the dialog.



Chapter 0: Introduction to JMP Statistical Software 5

Column Settings

‘mame’ in Takle 'Big Class'
Column Mame qame
Data Type Character &
Modeling TYpe  Nominal &
Field Width

Mew Property = [ Lock

Current Properties Motes

Click to edit and key in comments about
aptional fem column

.usually used as a label variable in plots

Remowve Property

‘weeight' in Table 'Big Class'
Calumn Mame sy eight
Data Type Mumeric =
Modeling Type | Continuous &
Faormat Fixed Dec = Width: Dec:El

Mew Property & [ Lock

Notice that:

* the variable name has data type character and weight has data type numeric.
* the format for weight is Fixed Dec with a width of 5 and no decimal places.

* both variables have notes attached to them.

The modeling type of a variable is very important. It is not just a descriptive tag but rather it tells JMP
how to analyze and graph the data. For example, the Distribution command displays histograms and
boxplots for “Continuous” variables and stacked bar charts for “Nominal” variables.

Note: The default modeling type of numeric data is “Continuous” and the default modeling type of
character data is “Nominal.”

Entering and Saving Data
To process data in JMP, it must be in a JMP data table. You build a JMP data table either by:

* Creating a new table with the New command in the File menu and filling it with values by typing
or pasting values into the data grid, constructing a formula, or using an external measuring
instrument, or

* Importing data from a text file or from another application with the Open or the Database
command in the File menu.
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Creating a New JMP Data Table

The New command in the File menu displays an empty data table with no rows and one column, named
Column 1.

To add variables:
* use the New Column or Add Multiple Columns command in the Cols menu.

To add individuals:
* use the Add Rows command from the Rows menu, or

» simply type in a cell anywhere beyond the last row of the table.

You can use the usual editing commands, such as cut and paste, to enter data values. You can also use
drag and drop to copy or rearrange columns.

Example: Binge drinking and gender

A survey of 17,096 students in U.S. four-year colleges collected information on drinking behavior. One
question of interest was the relationship between binge drinking and gender. Here are the data
summarized by gender and frequent binge drinking.

Frequent Binge Drinker Gender | Count
Yes Female 1684
Male 1630
No Female 8232
Male 5550

Let’s create a JMP data table for the data.

1. Select File = New from the menu bar.

© O 6 | untitled 3
T T30
*10/0 Rows Column 1

Adding Columns

2. Select Cols = Add Multiple Columns to accommodate the three variables Frequent Binge
Drinker, Gender, and Count.
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Add Multiple Columns
Data Tahle: untitled 3
Column prefix: m
How many columns to add: j

Add Where
: Befare first Column

%) After last Column

:: After Selected Column:

Data Type
@ Mumeric
: Row State
:: Character

Field Width:

'.:"' ' Cancel l ( 0K )

3. Enter 3 after How many columns to add and press OK.
Now let’s change the name of the first column to Frequent Binge Drinker.
4. Select the first column of the data grid to highlight that column.

a. Click on the name Column 1 to highlight the column name.
b. Type Frequent Binge Drinker.

®o06 #) untitled 3

¥-3/0 Cols [l | Frequent
=lo/0 Row Binge Dirir| Column 2 Column 3

5. Repeat Step 4 on the other columns to change the names to Gender and Count.
Setting the Data Type of a Column

By default, columns contain numeric data. However, Frequent Binge Drinker and Gender have
character values. Use the Column Info command to change the data type of the variable Frequent
Binge Drinker.

6. Select the first column, Frequent Binge Drinker.
a. Select Cols = Column Info.
b. Select Character from the pop-up menu for Data Type.
c. Press OK.

7
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a8aes Column 1
I ‘Column 1° In Tahle ‘untitled @
Column Name |F:euuen: Binge Drinker O Lock " Cancel )
Data Type Mumeric (__Apply )

Initial Dara Values  wmijssing/Empry™ M Rows —d

Column Properties ¥
—I
7. Repeat Step 6 for the second column, Gender, to change its data type to character.
Adding Rows

Adding rows is easy.

8. Select Rows = Add Rows from the menu bar and enter 4 and press OK.

| Add Rows

Data Table: untitled 3
How many rows to add: H

Where?
s
. At start

@ At end

—
) After row:

® ( Cancel ) &-Bib—-)
—

Entering Data

Entering data into the data table is similar to entering data into a spreadsheet.

806 #) untitled 3
' "\MQ:E Frequent Binge m
[*]5/0 Row Drinker Gender Count
1|Yes Female 1684
2 |Yes Male 1630 .
3 |No | - "
4 | | . v
€ ) 4[>

9. Select the first cell in the first row and enter Yes.
a. Press the Tab key, enter Female, press Tab again, and enter 1684.
b. Press Return and enter Yes.
c. Press the Tab key, enter Male, press Tab again, and enter 1630.
d. Continue until you have finished entering the data.

In the next section, you will learn how to save the data table for later use.
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Saving and Naming a Data Table

The Save command in the File menu writes the current JMP data table to a file.

Note: JMP analysis windows are not saved with the data table. However, you can use JMP tools to copy
reports to other applications or you can save the JSL script that produced the analysis.

Example: Binge drinking and gender (continued)

To save the data table for further analysis:
1. Select File = Save.

2. Type Binge Drinking.jmp in the Name field and press Save.

Importing Data

The Open command in the File menu directly reads existing JMP data tables, text files with any column
delimiter, Excel files, JMP journal and script files, and SAS data sets into JMP data tables. Also, under
Windows, the Database command can access any database on your system that has an ODBC driver. We
illustrate importing text files for Windows and Macintosh OS X computers here.

Windows Text Import

JMP offers two choices for importing text files under MS Windows. From the File of type drop-down
list, you may choose:

» Text Import Files, which opens the file and creates a JMP data table using either the default rules
(set in the preferences panel) to interpret end-of-field and end-of-line delimiters, or the best guess
heuristics of JMP. These are sufficient for a rectangular text file with no missing fields, a consistent
delimiter between fields or fixed width fields, and an end-of-line delimiter.

* Text Import Preview, which allows you to modify the default field and column specifications and
displays default variable names, variable data types, and data values for the first two individuals.

Example: Is a new teaching method effective?

An educator believes that new directed reading activities will help elementary school pupils improve
some aspects of their reading ability. A class of 21 third-grade students took part in the new directed
reading activities and another third-grade class of 23 followed the same curriculum without these
activities. Suppose that the Degree of Reading (DRP) test scores for the 44 students are found in the text
file jm-reading.txt from the Web site. We will import the information in that file into a JMP data table.

1. Download the files from the Web site. Select File = Open from the menu bar and locate the file
jm-reading.txt using the usual file open dialogues.
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Open Data File

Loak jr: @'Desktup v Y BF EF [ad-

By BMy Docurments

A :3 :J My Computer
My Recent %My Metwork Places
Documents Csecr

Desktop

)

by Documents

or

My Computer

File name: jm-reading b Open

‘% Files of type: |Te:-:t Files [* bet* cav:™ dat;” bsw) V| [ Caricel ]

My Mebwork, Help
Select this filter the next time this dialog iz invoked =
4 i

Open az () Data, using Text Import preferences

() Data, using best guess
(%) D ata with preview
() Plain text inta 5 cript windows

2. ldentify the text file in the panel that opens.
a. Select Text Import Preview from the Files of type menu.
b. Select the folder that holds the file.
c. Select the file jm-reading.txt.
d. Click Open.
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11

& Import C:\Documents and Settings\carl schwarz\Desktop\jm-reading. txt @

My

id T oup i drp

1 Treat o 24

2 Treat ] S5a

3 Treat Q 43

4 Treat 0 59

= Treat o 55

& Treat ] 5z

7 Treat Q 71

g Treat 0 B2 b

< >

) Delimited fizlds End Of Field End Of Line

O Fixed width fields | [ Tab [ comma =CR=+=LF= [ Semicolon

Space | Other =CR= L1 other

Spaces |:| <LF= |:|

File contains column names on line: | 1
Crata starts on Iine: Humhber of Lines: 1]

Strip enclosing guotes Two-digitwear rule:; 10-90 (default) w

[] Recognize apostrophe as quotation mark (not recommended)

3. a. Change the four column names to Student, Group, DRP, and Score, respectively.
b. Notice that JMP has chosen data types for these columns. You may change those choices.
¢. Click OK.

The following JMP data table is created.
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o] jm-reading g@g

= jm-reading 4 - ~
- Source = | i group a drp
1 1| Treat ] 24
2 2| Treat ] G
3 3| Treat 1] 43
4 4 | Treat 1] a4
] 8 | Treat 1] a8
5] B | Treat 1] a2
T T | Treat ] T
- olumns (410) a 3 | Treat 0 B2
:f :;mup 9 3 | Treat 0 43
Y 10 10 [ Treat 1] a4
d dm 11 11| Treat 0 49
12 12 [ Treat 1] ar
13 13 [ Treat 1] 61
14 14 [Treat 1] 33
14 15| Treat 1] 44
16 16 | Treat 1] 46

Notice that the data for the second group of subjects is placed directly below the data for the first group
rather than adjacent to it as one often sees in textbooks. Recall that, in a JMP data table, the rows are the
individuals and the columns are the variables.

Macintosh Text Import

To import text data on the Macintosh, first select All Text Documents from the Enable field. The Open
As menu then appears and gives four choices:

» Text opens the file in a text editing window without creating a JMP data table.

* Data (Best Guess) opens the file and creates a JMP data table using the best guess heuristics of
JMP to arrange the data.

* Data (Using Preferences) opens the file and creates a JMP data table using the default rules (set in
the preferences panel) to interpret end-of-field and end-of-line delimiters.

* Data (Using Preview) opens the file, creates a JMP data table using delimiters that you designate,
and displays default variable names and data types and the data values of the first two individuals.

We illustrate the last choice.
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Example: Is a new teaching method effective?

An educator believes that new “directed reading activities” will help elementary school pupils improve
some aspects of their reading ability. A class of 21 third-grade students took part in the new directed
reading activities and another third-grade class of 23 followed the same curriculum without these
activities. Suppose that data for the 44 students are found in a text file jm-reading.txt on the Web site.
Let’s import the information in that file into a JMP data table.

1. Download the file from the Web site. Select File = Open from the menu bar and navigate to the file
using the standard file open dialogues.

"8 & Open

m] [ []JMPDatasets Wy Q

DEVICES | 3 jm-reading.txt | Preview:
___J Macinto... -

£ iDisk

SHARED
= michaels

PCSBSnc...
& pcsbssood TXT

PLACES . ,
E : Name jm-reading.txt

skttt Kind Plain Text
£ carlschw... I I Size 4 KB on disk I

A Applicati... v «— — — — — — — — — ) < |

—

4 | @

Open As: ' Data (Using Preview) F+ ] I

!’:Cancel :: ( Open )

2. Identify the text file in the panel that opens.
a. Select All Text documents from the Enable menu.
b. Select the folder that holds the file.
Select the file jm-reading.txt.
Select Data (Using Preview) from the Open As menu.
Click Next and then Import.

/e

@
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™ ™ Import fUsers/carlschwarz/Desktop/JMP Manuals/BusinessStatimpManual /JMPDatasets/j...

id group g drp m
1 Treat 0 24
2 Treat 0 56
3 Treat 4] 43
4 Treat 4] 59
5 Treat 0 58
6 Treat 0 52
Treat 0 71l
8 Treat 0 62
9 Treat 4] 43
10 Treat 0 54 T
11 Treat 0 49
@ Delimited ﬁE'dS End Of Field End Of Line
() Fixed width fields _ _ ; _ _
| | Tab | | Comma <CR>+<LF> || 5emicolon
M space [ | Other " <CR> [ | Other

#spaces || " <LF> [ 1]

¥ File contains column names on line:
Data starts on line:] 2]  MNumberof Lines] 0]

Strip enclosing quotes Two-digit year rule: 10-90 (default) v

[ | Recognize apostrophe as guotation mark (not recommended)

' i ril i
m [ Cancel ) . Next

3. a. Notice that JMP has used the character values in the first row as the column names. You may
change these choices here.
b. Notice that JMP has chosen data types for these columns. You may change those choices also.
c. Click Next.

The JMP data table is created, part of which is shown below.
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jm-reading -
- |
= | i group g drp
1 1 | Treat 0 24
2 2 |Treat 0 56
3 3 | Treat 0 43
4 4 | Treat 0 59
5 5 | Treat 0 58
5] 6 | Treat 0 52
7 7 | Treat 0 71
g 8 | Treat 0 62
9 9 | Treat 0 43
10 10 | Treat 0 54
11 11 |Treat 0 49
L 12 12 | Treat 0 57
13 13 | Treat 0 61
14 14 | Treat 0 33
15| k 15 |Treat 0 44
16 16 | Treat 0 46
17 17 | Treat 0 67
18 18 | Treat 0 43
19 19 | Treat 0 49

Notice that the data for the second group of subjects is placed directly below the data for the first group
rather than adjacent to it as one often sees in a textbook. Recall that, in a JMP data table, the rows are the
individuals and the columns are the variables.

Remarks
» JMP automatically detected that Group should be given a data type of character.

* Default choices for End Of Field and End Of Line delimiters and other import settings can be changed
in the preferences panel. See Section 0.4.2 for details.
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Working with Variables and Individuals

Selecting Individuals and Columns

€ Z
iLig Class
name age sex | height | weigh m
KATIE 12 |F 59 9p
LOUISE 12 |F 61 12F |
JANE 12 |F 55
JACLYN 12 |F b6 145
LILLIE 12 |F 52 64
TIM 12 |M 60 84 3
M

U

Select the area marked:

=) to select a row/individual
& to open the left side panels
C to deselect all rows/individuals
C to deselect all columns/variables
€ to select a column/variable
& to change the column/variable name
Z o editacell
After selecting an individual (or a variable), press the:

+ Shift key to select a block of adjacent individuals (or variables).
» Ctrl (command on the Macintosh) key to select nonadjacent individuals (or variables).

You can also use the Row Selection command in the Rows menu and the Select Where... option to
select rows/individuals that meet a criterion. Suppose that you wish to select the female students in the

JMP data table Big Class that is stored in the Sample Data folder located within the JMP application.

Example: Selecting female students

1. Select File = Open = Big Class.

2. Select Rows = Row Selection = Select Where...
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( Remove Selected Conditions )

@

Select Rows
Select rows from 'Big Class’ where...
[name Currently Selected Rows. =
age @ Clear Current Selection
sex
height
\ruweigght C Extend Current Selection
—~ .
|_J) Select From Current Selection
[ Match Case
" equals F%«i A

Add Condition

Select Rows

* | it all conditions are met

if any condition is met

( Cancel ) (—-H

a. Select sex in the list of columns.
b. Select equals (the default) in the comparison menu.
c. Type F as the value.

d. Select OK.
®0O60 Big Class
v 0 Cols [~
E:;m name age sex | height | weight
1 [KATIE 12 |F 59 95
2 | LOUISE 12 |F 61 123
3 |JANE 12 |F 55 74
4 | JACLYN 12 |F b6 145
5 | LILLIE 12 |F 52 b4
6|TIM 12 |M 60 84
7 [JAMES 12 |M 61 128
8 |[ROBERT 12|M 51 79
9 | BARBARA 13 |F B0 112
10 | ALICE 13 |F Bl 107
11 | SUSAN 13 |F 56 67
12 |JOHN 13 | M G5 98
13 |JOE 13| M 63 105
14 |MICHAEL 13| M 58 95
15 |DAVID 13 |M 59 79 .
16 |JuDY 14 |F b1 81 v
| b Ya|»| 2
e

Changing the State of an Individual

There are times when we wish to:
* exclude one or more individuals from analysis.
* hide one or more individuals in a plot.
* color points representing one or more individuals in a plot.

17
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These tasks are easily accomplished in JMP by changing the state of an individual. The operations
involve individuals so commands to perform them are found on the Rows menu.

m Cols DOE Analyze G

Exclude/Unexclude

Hide/Unhide

Label/Unlabel

Colors »
Markers »
Next Selected ¥+
Previous Selected 3 -
Row Selection »

Clear Row States
Color or Mark by Column...
Row Editor

Add Rows...
Move Rows...
Delete Rows

To illustrate these features, we will first produce an analysis with all individuals in their default states.

Example: Changing the state of individuals

1. Deselect all individuals in Big Class by selecting Rows = Clear Row States.

2. Select Analyze = Fit Y by X.
a. Select the column weight and click Y, Response.
b. Select the column height and click X, Factor.
c. Press OK.

3. Click on the red triangle next to Bivariate Fit of ... and select Fit Line from the menu that opens.

a8ene Big Class: Fit Y by X
¥ [-Bivariate Fit of weight By height
180
160
140
5
=120
E

100+

804 -

60

50 55 60 65 70
height

e

[*l—Linear Fit

¥ Linear Fit
weight = -127.1452 + 3.7113549 height

» Summary of Fit
—
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Now change the state of some individuals. Let’s color the female students red and change their plotting
symbol.

4. a. Use the Rows Selection command in the Rows menu to select the female students as we did above
in Step 2.
b. Select Rows = Colors = Red; then select Rows = Markers = X.

Let’s hide all 12-year-olds in the scatterplot.

5. Select rows where the age is 12 by using the Rows Selection command again.
a. Select Rows = Row Selection = Select Where...
b. Select age in the list of columns.
c. Type 12 as the value and press OK.

6. Select Rows = Hide/Unhide.

Finally, we will set individual 40, Lawrence, to be excluded from future analyses. Lawrence is the tallest
and heaviest student.

7. Select row 40 and then Rows = Exclude/Unexclude.

The data grid updates to indicate all of the new row states.
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®0 e Big Class
v 0 Cols[] ~
E::N name age sex | height | weight
o 6|TIM 12 |M 60 84
& 7 JAMES 12 |M 61 128
@ 8 |ROBERT 12 |M 51 79 -
b 9 |[BARBARA 13 |F 60 112
x 10 [ALICE 13 |F 61 107
x 11 [SUSAN 13 |F 56 67
12 [JOHN 13 |M 65 98
13 [JOE 13 |M 63 105
14 [MICHAEL 13 |M 58 95
15 [DAVID 13 |M 59 79
x 16 [JuDY 14 |F 61 81
x 17 [ELIZABETH 14 |F 62 91
x 18 [LESLIE 14 |F 65 142
x 19 [CAROL 14 |F 63 B4
X 20 |PATTY 14 |F 62 85
21 |FREDRICK 14 (M 63 93
22 |ALFRED 14 M 64 99
23 |[HENRY 14 |M 65 119
24 |LEWIS 14 |M 64 92
25 |[EDWARD 14 | M 68 112
26 |CHRIS 14 (M 64 99
27 |JEFFERY 14 (M 69 113
x 28 | MARY 15 |F 62 92
x 29 [ AMY 15 |F 64 112
30 |ROEBERT 15| M 67 128
31 [WILLIAM 15 |M 65 111
32 |CLAY 15 |M 66 105
33 |MARK 15 |M 62 104
34 |DANNY 15| M 66 106
x 35 [MARTHA 16 |F 65 112
x 36 | MARLAN 16 |F 60 115
37 |PHILLIP 16 (M 68 128
b 38 |LINDA 17 |F 62 116
39 |KIRK 17 |M 68 134 A
& 40 |LAWRENCE 17 |M 70 172 v
€ : ) 4w 2

e ————

Move the Fit Y by X window to the front so that you can see the effect of these changes on the analyses.

8. Select Window = Big Class: Fit Y by X.

Notice that the female data is red, the 12-year-olds are invisible, and all 40 individuals (rows) are still
used in the analyses.
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eoe Big Class: Bivariate
¥ [-IBivariate Fit of weight By height
180

1604

140+

weight

1204

100+

&0+

&0 — .
50 55 60 @5 70
height

—

[xl—Linear Fit

¥ Linear Fit
weight = -127.1452 + 3.7113549 height
P Summary of Fit

Move the cursor to the point in the upper-right-hand corner. Notice that Lawrence is still there. To see the
effects of changing the state of Lawrence to exclude, we must redo the analysis with Lawrence in that
state. Let’s use a shortcut to do that.

9. Click on the red triangle next to Bivariate Fit of weight By height
a. Select Script = Redo Analysis on the menu that opens.

Notice that Lawrence is no longer in the scatterplot and the equation of the line is quite different.

8eo8 Big Class: Bivariate
¥ [-|Bivariate Fit of weight By height M
150 |
140 x |
130 |
120 :
£1104 |
21004 |
a0 |
80 :
70 |
60— T T T T T T T |
55 60 65 70 |
height W
[x]—Linear Fit
¥ Linear Fit

weight = -99.08341 + 3.2451698 height
» Summary of Fit

Creating a New Variable Using a Formula

Sometimes we may wish to add or subtract the values of several variables for each individual. For
example, we may want to look at the differences between before and after values in a study. Often, a
statistician needs to re-express a variable. For example, the square root of the variable amount might
follow a more recognizable pattern than the amounts themselves. Or the relationship of the logarithm of
the dose of a new medication and the clinical response may be simpler to understand and describe than
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the dose-response relationship. At other times, we may wish to randomly generate data from a particular
distribution. In each case, we need to construct a new variable from one or more existing variables or
from a mathematical or statistical function. The Formula Editor in JMP is a powerful and easy-to-use tool
for doing these tasks and more. We illustrate its use with a simple example.

Example: Finding the ratio of the weight to height of a child

The JMP data table Big Class contains the heights and weights of 40 teens and preteens. It is likely that
their heights and weights are related. We might wonder, then, if the ratio of a child’s weight to his or her
height is relatively constant. To investigate this, we decide to construct a new variable—weight divided
by height.

1. Select File = Open and select Big Class.jmp from the Sample Data folder that comes with the JMP
application.

2. Select Cols ® New Column.

Add Multiple Columns...

Goto ...
Preselect Role >
Validation »

3. Name the column Adjusted Wt and select a format of Fixed Dec with 2 decimal places.

ene New Column

[ew column in Big Class ( ok )
Column Narr Adjusted Wi 1 Lock -
Ly Cancel y)
Data Type Numeric ¥ e
: (_Apply )

Medeling Type Continuous ¥
Format Besty Width[ 10] (" Next )
i i '... He|p ...I

e —

4. Select Column Properties = Formula to open the Formula Editor window.

We now build the formula to calculate the variable Adjusted Wt.

a. Press + on the keypad and select weight from the list of columns.
b. Select the denominator of the ratio and then select height from the list of columns.
c. Press Apply. Look at the data table.
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eoe Adjusted Wt
Table Columns ¥ = Functions (grouped) ¥ A
e e ittt bt s 0K
name =]~ Row ;)
age X +|2 Numeric AP
sex wligls Transcendental @
height +|t=4|  Trigonometric _
weight Character (_Apply )
Adjusted Wt Comparison

Conditional -

Probability -

Statistical ¥ @

Help

The values of the ratio Adjusted Wt range from about 1.20 to 2.50 1bs/inch.

! 4

Remarks

)4

®@0e Big Class
¥-£/0 Cols[~]
[l40/0 name age sex |height | weight | Adjusted Wt m
1 |KATIE 12 |F 59 95| 1.61016949
2 [LOUISE 12 |F 61 123 | 2.01639344
3 [JANE 12 |F 55 74| 1.34545455
4 [JACLYN 12 |F 6E 145 2.1969697
5 [LILLIE 12 |F 52 b4 | 1.23076923
6 [TIM 12|M 60 84 1.4
7 [JAMES 12|M bl 128 | 2.098360606
8 |ROBERT 12| M 51 79| 1.54901961 |
9 | EAREARA 13 |F G0 112 | 1.86666667| *
- 10 1AILICE 13 | F Al II"I;.FI 1 7RANARIR “'/

| 3

o
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» Look at the rich list of functions by selecting Transcendental from the Functions (grouped) list or
by selecting Random from the Functions (grouped) list.
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Random Uniform
Random Mormal

Random Exp
Random Gamma
Random Beta
Random Cauchy
Exp Random Triangular
Log Random Integer
Lagin Random Binomial
Squish : ' ,
Root Random Megative Binomial
Factorial Random Geometric
NChoosek Random Poisson
Beta Random Reset
Gamma Random Seed
LGamma Random SeededUniform
Arrhen!us Random SeededNormal
Arrheniusiny
Logit Col Shuffle
ScheffeCubic ~ Resamplefreq
Transcendental Functions Random Functions

Customizing Your JMP Environment

This section discusses the JMP Starter Window, table information panels, and setting preferences. We
make specific recommendations for and show you how to customize your session environment.

The JMP Starter Window

If a JMP data table is not selected before starting, JMP may begin by opening a special navigation
window—the JMP Starter Window.

B% JMP Starter =3

Click Category: Opening and Creating Data Tables and Text

L)
Basic |'f‘| MNew Data Table Create a new Data Table, and dizplay az a grid in a new window.
Model —
Multivariate
Survival Open Data Table |  Open a JMP file containing a data table, or import it from another file.
Graph
Measure L) -
T Mew Script Write and edit text, including scripts.
Control JsL
DOE
A -
Tables @ Open Script Open a file containing text, a script for example.

@ Open Journal Open a file containing journaled JMP output.
s | Examine and =&t gystem preferences.
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The JMP Starter Window presents an alternate way to access JMP commands that we will not use. All
these commands are accessible through the menu bar. We recommend that the Starter Window be closed
at start-up. See “Setting Preferences” below for details.

Setting Preferences

You may customize your session environment using the Preferences command. The Preferences
command displays a panel with tab pages. The following displays the preferences panel for the Windows
environment. Most preferences are also available on the Macintosh.

Example: Setting preferences

Let’s set preferences to close the Starter Window and the table information panels at start-up.

1. To open the preferences window, select File = Preferences under Windows, or JMP = Preferences
in Mac OS X.

JMP-5SE: Preference Settings

~ Show the Tip of the Day at startup
E Initial Splash Window
Initial IMP Starter Window
Jj [ select Individual Excel Worksheets
Reports [Juse Excel Labels as Headings
[ Auto match brackets in script editor
Ij [C]Retain exact toal positions
Tables Scollbararowstyle  [Traditonal v
lﬁ - Scrall bar thumb style !Propoﬁl_\f_i

Platforms
Show menu tips

E] [ nitial Window List
HextDaniies Show window list when windows are maximized
Q Save Text Files as Unicode

Windows Specific [15ave Seripts in English

@

Fonts:

el

Communications %
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| Preferen
m E Show the Tip of the Day at startup
“.f_ : E Initial 5plash Window
General 1 [ Initial JMP Starter Window
e 1 | Select Individual Excel Worksheets
Reports | " Use Excel Labels as Headings
‘| Enter Key moves down
T;&blei 1 ¥ Save Text Files as Unicode
" ! ] Save Scripts in English
Platforms 1
|
0 |

e
Text Data Files
[L] -

L4

Mar 05 Samrinos

2. Select the General icon.
a. Deselect Initial JMP Starter Window and press OK.

Open the preferences panel again and look at the other icons. Most options are either off or on. Check the
items that you want or select from a menu of items. You can press Apply to see the results without
closing the Preferences window.



